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PROGRAM OUTCOMES 
 

1. Engineering knowledge: Apply the knowledge of mathematics, science, engineering fundamentals, 

and an engineering specialization to the solution of complex engineering problems. 

2. Problem analysis: Identify, formulate, review research literature, and analyze complex engineering 

problems reaching substantiated conclusions using first principles of mathematics, natural sciences, and 

engineering sciences. 

3. Design/development of solutions: Design solutions for complex engineering problems and design 

system components or processes that meet the specified needs with appropriate consideration for the 

public health and safety, and the cultural, societal, and environmental considerations. 

4. Conduct investigations of complex problems: Use research-based knowledge and research methods 

including design of experiments, analysis and interpretation of data, and synthesis of the information to 

provide valid conclusions. 

5. Modern tool usage: Create, select, and apply appropriate techniques, resources, and modern 

engineering and IT tools including prediction and modeling to complex engineering activities with an 

understanding of the limitations. 

6. The engineer and society: Apply reasoning informed by the contextual knowledge to assess societal, 

health, safety, legal and cultural issues and the consequent responsibilities relevant to the professional 

engineering practice. 

7. Environment and sustainability: Understand the impact of the professional engineering solutions 

in societal and environmental contexts, and demonstrate the knowledge of, and need for sustainable 

development. 

8. Ethics: Apply ethical principles and commit to professional ethics and responsibilities and norms of 

the engineering practice. 

9. Individual and team work: Function effectively as an individual, and as a member or leader in 

diverse teams, and in multidisciplinary settings. 

10. Communication: Communicate effectively on complex engineering activities with the engineering 

community and with society at large, such as, being able to comprehend and write effective reports and 

design documentation, make effective presentations, and give and receive clear instructions. 

11. Project management and finance: Demonstrate knowledge and understanding of the engineering 

and management principles and apply these to one’s own work, as a member and leader in a team, to 

manage projects and in multidisciplinary environments. 

12. Life-long learning: Recognize the need for, and have the preparation and ability to engage in 

independent and life-long learning in the broadest context of technological change. 

 

PROGRAM SPECIFIC OUTCOME(PSOs) 
 

PSO1: Ability to apply the acquired knowledge of basic skills, mathematical foundations, principles of 

electronics, modeling and design of electronics based systems in solving engineering Problems. 

PSO2: Ability to understand and analyze the interdisciplinary problems for developing innovative 

sustained solutions with environmental concerns. 

PSO3: Ability to update knowledge continuously in the tools like MATLAB, NS2, XILINIX and 

technologies like VLSI, Embedded, Wireless Communications to meet the industry requirements. 

PSO4: Ability to manage effectively as part of a team with professional behavior and ethics. 



SYLLABUS 
1910604 – MEDICAL ELECTRONICS SYSTEM DESIGN LABORATORY 

 

OBJECTIVES: 
The student should be made: 

 

 To familiarize with the electronic components used in medical electronics system.

 

 To enhance the use of sensors used for medical applications.

 

 To design electronic circuits for various signal processing applications.

 

 To perform PCB design using software and to explain the various processes involved.

 

 To provide the knowledge in assembling and testing of the PCB based Medical electronic 

circuits.

 

LIST OF EXPERIMENTS 
 
 

1. Design a Power Supply for Low Power Wearable Devices. 

 

2. Design of a Bio Amplifier. 

 

3. Design and setup a notch filter circuit and Active Band Pass Filter. 

 

4. Design and setup a threshold detector, sample and hold circuit using op-amp. 

 

5. Design and setup a Patient Isolation Circuit. 

 

6. Design of body temperature measuring circuit using thermistors. 

 

7. Design of Plethysmography circuit. 
 

8. Design of Pace Maker circuit. 
 

9. Design and setup a circuit for skin contact impedance. 
 

10. Design of Bio-Telemetry using IC4046. 
 

11. Design of Bio-Electrode Equivalent Circuit. 
 

12. Study of PCB design software (open source) like KiCad, Eagle, etc. 

 

 
 

TOTAL: 60 PERIODS 



OUTCOMES: 

At the end of the course, the student should be able to: 

 
 

 Understand the usage of electronic components and medical sensors used in medical electronics system. 

 
 

 Create electronic circuits for various signal processing applications in medical electronic system. 

 
 

 Conduct experiments using designed and assembled circuits for medical applications. 

 
 

 Design and simulate various electronic PCB required for prototyping and testing using software tools 

and testing equipments. 

 
 Identify, formulate, and solve engineering problems associated with assembly and testing of Medical 

electronic circuits. 



LIST OF EXPERIMENTS 
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1. Design a Power Supply for Low Power Wearable Devices. 

 

2. Design of a Bio Amplifier. 

 

3. Design and setup a notch filter circuit and Active Band Pass Filter. 

 

4. Design and setup a threshold detector, sample and hold circuit using op-amp. 

 

5. Design and setup a Patient Isolation Circuit. 

 

6. Design of body temperature measuring circuit using thermistors. 

CYCLE-II 

1. Design of Plethysmography circuit. 
 

2. Design of Pace Maker circuit. 
 

3. Design and setup a circuit for skin contact impedance. 
 

4. Design of Bio-Telemetry using IC4046. 
 

5. Design of Bio-Electrode Equivalent Circuit. 
 

6. Study of PCB design software (open source) like KiCad, Eagle, etc. 

 

 

 

 
ADDITIONAL EXPERIMENTS 

 

1. Characteristics of PLL. 
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CIRCUIT DIAGRAM 
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EXPT. NO: 1 DESIGN OF POWER SUPPLY FOR LOW POWER 

WEARABLE DEVICES 

 

AIM: 
To design a power supply for low power wearable devices. 

 
 

APPARATUS REQUIRED 
 S.NO ITEM RANGE QUANTITY 

1. Diode 1N4007 04 

2. IC IC7805 01 

3. Step down transformer 230 V/ 9 V, 1A 01 

4. Resistor 100Ω 01 

5. Capacitor 0.33μF, 0.1μF Each 1 

6. Electrolytic Capacitor 1000µF/25V 01 

7. Function Generator 3 MHz 01 

8. RPS (0-30)V 01 

9. CRO 30 MHz 01 

10. Bread Board  01 

11. Connecting Wires Single stand few 

PRE-LAB QUESTIONS 
 

1. Design and create a SPICE model of a bridge-type, full-wave rectified, dc power 

supply using a filter capacitor. 

2. Analyze the circuit for different values of filter capacitors. Observe the change in 

ripple content and comment on your observation. 

3. Analyze the circuit for different load conditions. Observe the change in ripple 

content and comment on your observation. 

4. From the IC 7805 datasheet, write down the minimum, typical and maximum 

values of the output voltage V0. 

5. Determine the smallest value of the input voltage VI for which IC7805 can still 

work as a voltage regulator. 

 

THEORY: 
Every electronic circuit is designed to operate off of supply voltage, which is usually 

constant. A regulated power supply provides this constant DC output voltage and 

continuously holds the output voltage at the design value regardless of changes in load 

current or input voltage. 

The power supply contains a rectifier, filter, and regulator. The rectifier changes the AC 

input voltage to pulsating DC voltage. The filter section removes the ripple component and 

provides an unregulated DC voltage to the regulator section. The regulator is designed to 

deliver a constant voltage to the load under varying circuit conditions. The two factors that 
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can cause the voltage across the load to vary are fluctuations in input voltage and changes in 

load current requirements. 

Load regulation is a measurement of power supply, showing its capacity to maintain a 

constant voltage across the load with changes in load current. Line regulation is a 

measurement of power supply, showing its capacity to maintain a constant output voltage 

with changes in input voltage. 

 

DESIGN 
Design a 5 V DC regulated power supply to deliver up to 1A of current to the load 

with 5% ripple. The input supply is 50Hz at 230 V AC. 

Selection of Voltage regulator IC: 

Fixed voltage linear IC regulators are available in a variation of voltages ranging from -24V 

to +24V. The current handling capacity of these ICs ranges from 0.1A to 3A. Positive 

fixed voltage regulator ICs have the part number as 78XX. The design requires 5V fixed 

DC voltage, so 7805 regulator IC rated for 1A of output current is selected. 

Selection of Bypass Capacitors: 

The data sheet on the 7805 series of regulators states that for best stability, the input bypass 

capacitor should be 0.33µF. The input bypass capacitor is needed even if the filter capacitor 

is used. The large electrolytic capacitor will have high internal inductance and will not 

function as a high frequency bypass; therefore, a small capacitor with good high frequency 

response is required. The output bypass capacitor improves the transient response of the 

regulator and the data sheet recommends a value of 0.1µF. 

Dropout voltage: 

The dropout voltage for any regulator states the minimum allowable difference between 

output and input voltages if the output is to be maintained at the correct level. For 7805, the 

dropout voltage at the input of the regulator IC is Vo +2.5 V. 
Vdropout = 5+2.5 = 7.5V 

Selection of Filter Capacitor: 

The filter section should have a voltage of at least 7.5V as input to regulator IC. 

That is Vdc = 7.5 V 

 

 

Figure 2: Output wave shape from a full-wave filtered rectifier 
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PROCEDURE: 
 

1. Power Supply 

1. Connect the circuit as shown in Figure 1 . 

2. Apply 230V AC from the mains supply. 

3. Observe the following waveforms using oscilloscope 

Volt/div = Time/div = Volt/div = Time/div= 

  

Graph 1: Waveform at the secondary of the transformer Graph 2: Waveform after rectification 

Volt/div = Time/div = Volt/div = Time/div= 
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POST-LAB QUESTIONS 
 

1. Why is the ripple voltage larger at full load? 

2. Under full load conditions, what is the power dissipated by the regulator IC? 

3. Comment on the efficiency of the circuit for a minimum output voltage and a maximum output 

voltage. 

4. Identify the short-circuit current of 7805 from data sheets. 

5. What modification needs to be done to obtain a variable output voltage? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
RESULT: 

Thus the regulated power supply was designed for low power wearable devices. 
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CIRCUIT DIAGRAM: 
 
 

 

 

 
 

PIN DIAGRAM 
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EXP NO .2 DESIGN OF BIO-AMPLIFIER  
 

 

AIM: 
 

 
To design and setup a bio amplifier for a gain of 10 and to calculate the CMMR. 

 

DESCRIPTION 
Input  : Set the dc input voltage in both the input terminals V1 and V2. 

Output : Vary the resistor R1 to obtain the output voltage with varying gain. 

 
 

APPARATUS REQUIRED : 
 

 
 

S.NO ITEM RANGE QUANTITY 

1 Op-amp IC741 1 

2 Resistors 10k 6 

3 Decade Resistance box - 1 

4 Multimeter - 1 

5 RPS DUAL(0-30) V 2 
 

PRE-LAB QUESTIONS 
1. What is an op-amp? Why it is called so? 

2. Define the term input offset voltage, input bias current, gain bandwidth product. 

3. Define slew rate in an op-amp. 

4. List the ideal characteristics of an op-amp. 

5. What are the building blocks of an op-amp? 

 

DESIGN: 
 

Assume the resistors in the differential amplifier stage to be of the same value R =10kΩ 

 

Using Superposition theorem the output of the Instrumentation amplifier is 

Vo = -(R/R)Va + (1+R/R)Vb = Vb-Va 

Where Va = -R2/R1(V1-V2) +V2 
and Vb = R2/R1(V1-V2)+V1 
Thus Vo = Vb-Va =(V1-V2) (1+2R2/R1) 

Gain of an Instrumentation amplifier is 
Av = Vo/(V1-V2) = (1+2R2/R1) 

For Av = 3 

3=(1+2R2/R1) 

Then R2 = R1 

Let R2 = 10kΩ then set the variable resistor R1 = 10KΩ 
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THEORY: 
 

Instrumentation Amplifiers are high gain differential amplifiers with high input impedance and a 

single ended output. They are mainly used to amplify very small differential signals from strain gauges, 

thermocouples or current sensing resistors in motor control systems. They also have very good 

common mode rejection in excess of 100dB at DC. The negative feedback of the top op-amp causes 

the voltage at Va to be equal to the input voltage V1. Likewise, the voltage at Vb is equal to the value 

of V2. This produces a voltage drop across R1 which is equal to the voltage difference between V1 

and V2. This voltage drop causes a current to flow through R1, and as the two inputs of the buffer op-

amps draw no current (virtual earth), the same amount of current flowing through R1 must also be 

flowing through the two resistors R2. This voltage drop between points Va and Vb is connected to the 

inputs of the differential amplifier which amplifies it by a gain of 1 (assuming that all the "R" resistors 

are of equal value). Then the overall voltage gain of the instrumentation amplifier circuit is 

The differential gain of the circuit can be changed by changing the value of R1. 

 
 

TABULATION : 
 V1 

(Volts) 

V1 

(Volts) 

R1 

(Ohms) 

Vo 

(Volts) 

Gain 

Theoretical 

1+2R2/R1 

Practical 

V0/V1-V2 

      

      

      

      

Thus the gain of the instrumentation amplifier can be varied over a range of 1.5 to 1.2 by varying the 

variable resistance R1 from 20K to 50K. 

PROCEDURE : 
 

1. Connect the components as per the circuit diagram. 

2. Initially set the variable resistor R1 to the minimum value and note down the output voltage and 

compute the gain. 

3. Repeat the procedure in step 2 for various values of R1 and note down the corresponding output 

voltage to find the range of gain. 

 

PRE-LAB QUESTIONS 
1. What are the advantages of negative feedback in an op-amp? 

2. List the linear and non-linear applications of an op-amp. 

3. What is an instrumentation amplifier ? 

4. List some applications of an instrumentation amplifier. 

 
RESULT : 

Thus the bio amplifier was designed using Op-Amp 741 IC and the gain was calculated. 
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CIRCUIT DIAGRAM-NOTCH FILTER 
 

 

 

 

 

MODEL GRAPH 
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EXP NO .3(A) DESIGN AND SETUP A NOTCH FILTER CIRCUIT 
 

 

AIM: 

(i) To design and setup a notch filter for a notch out frequency of 50Hz and plot the frequency 

response characteristics. 

. 

COMPONENTS REQUIRED: 
 

S.NO ITEM RANGE QTY 

1. IC 741 03 

2. Resistor 15KΩ, 33KΩ , 1KΩ, 1.5KΩ 

5KΩ, 10 KΩ 

 

Each 2 

3. Capacitor 0.1 µF,0.2 µF Each 2 

4. Function Generator 2MHz 01 

5. RPS (0-30)V 01 

6. DSO 30MHz 01 

7. Bread Board  01 

8. Connecting Wires Single stand few 

 

PRE-LAB QUESTIONS 
 

1. What is the stop band frequency of a notch filter? 

2. How deep should the notch of an active notch filter be? 

3. What are the disadvantages of a notch filter circuit? 

 

 
THEORY: 

 

Filter is a frequency selective circuit that passes electric signals of specified band of frequencies and 

attenuates the signals of frequencies outside the band. Notch filter is actually a 12 narrow band reject 

filter. This is because of its higher Q (> 10) it is commonly used for the rejection of a single 

frequency. The most commonly used notch filter is the twin –T network. 

This network consists of two T networks, one consisting of two resistors and a capacitor and the 

other consisting of two capacitors and a resistor. At the notch frequency, the filter shows maximum 

attenuation and the filter will pass all other frequency signals. The notch out frequency is given by 

fN = 1 / 2πRC 

The passive twin T-network has a relatively low figure of merit Q. To increase the value of Q, a 

voltage follower network is connected at the end of the twin T network. They are generally used in 
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communication and bio medical instruments for eliminating the undesired frequencies like power 

line frequency. 

 

 

 
 

 

 

TABULATION 
Vi = 1 Vpp 

F(Hz) Log F V0(V) Gain (dB) 

 

PROCEDURE: 
 

1. Setup circuit on the bread board. 

2. Connect the ±15V power supply. 

3. Feed a 1 Vpp sinusoidal input and vary the frequency from 10Hz to 1 KHz 

4. Vary the frequency of the sine wave in steps and note down the corresponding output voltage. 

5. Plot the frequency response curve on a graph sheet. 
 

6. Find the notch frequency. 
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CIRCUIT DIAGRAM-BPF 
 

 
 

 

 

MODEL GRAPH 
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EXP NO .3 (B) DESIGN AND SETUP AN ACTIVE BAND 
 

PASS FILTER. 
 

 

AIM: 
Design a second order active Butterworth low pass filter using IC 741 having upper cut-off 

frequency 1 KHz, also determine its frequency response and Design a second order active band pass 

pass filter using IC 741. 

 

COMPONENTS REQUIRED: 
 
 

S.NO ITEM RANGE QUANTITY 

1 Op-amp IC741 1 

2 Resistors 10K,1.5K,5.6 K 1 

3 Capacitor 0.1 F 1 

4 CRO - 1 

5 RPS DUAL(0-30) V 1 
 

 

PRE-LAB QUESTIONS 
 

1. What is an op-amp? Why it is called so? 

2. List the ideal characteristics of an op-amp. 

3. What are the building blocks of an op-amp? 

4. What is an electric filter? 

5. State the advantages of an active filter 

 
 

DESIGN: 
 

Given: 

Upper cut-off frequency fH = 1 kHz 

fH = 1/ (2RC) 

Let C = 0.1 F, R = 1.6 K

For n = 2,  (damping factor) = 1.414, 

Passband gain = Ao = 3 -  =3 – 1.414 = 1.586. 
 

Transfer function of second order Butterworth Low-pass filter is: 

1.586 

H(s) =                                             

S2 + 1.414 s + 1 

Now Ao = 1 + (Rf / R1) = 1.586 
 

Thus, Rf = 0.586Ri 

Let Ri = 10 k, then Rf = 5.86 k
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THEORY: 
 

 

Band Pass Filter: 

The cut-off frequency or ƒc point in a simple RC passive filter can be accurately controlled using just 

a single resistor in series with a non-polarized capacitor, and depending upon which way around they 

are connected, we have seen that either a Low Pass or a High Pass filter is obtained.By connecting or 

“cascading” together a single Low Pass Filter circuit with a High Pass Filter circuit, we can produce 

another type of passive RC filter that passes a selected range or “band” of frequencies that can be 

either narrow or wide while attenuating all those outside of this range. This new type of passive filter 

arrangement produces a 17 frequency selective filter known commonly as a Band Pass Filter or BPF 

for short. 

 
PROCEDURE:  

1. Connect the circuit as shown in diagram. 

2. Connect the DSO to the probes and switch it on. 

3. Check the graph for both positive and negative voltage and write down the output. 

 

 

TABULATION 
 

 
S.No. Frequency 

(Hz) 

Output 

VoltageVO(Volts) 

Voltage Gain 

Av=20 log Vo/Vi 
( dB) 
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POST-LAB QUESTIONS 
 

1. What is a band-pass filter? 

2. What is the frequency response curve of a band pass filter? 

3. What is the voltage gain magnitude of the bandpass filter? 

4. What is a second-order band pass filter transfer function? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RESULT: 

Thus the notch filter and active band pass filter was designed and the frequency response was 

analyzed. 
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CIRCUIT DIAGRAM 

 

 

 

 

 
 



17 SRMVEC/MDE/BE/LM/III/VI/1910604/MESDL/2023-24/EVEN 
 

EX.NO. 4(A) : DESIGN AND SETUP A THRESHOLD DETECTOR 
 

AIM 
To design design and setup a threshold detector, sample and hold circuit using op-amp for the 

following specifications;VUT = 0.5 v , VLT= -0.5v, Vsat = +12 V and -Vsat=-12V and Vref=0v. 

 

DESCRIPTION 
 

Comparator: 

Input : Sine input of 4V at 10KHz 

Output : Square Signal of 24 Vp-p at 10 KHz. 

Hysterisis loop : Set the CRO in XY mode and view the hysteresis loop. 

 

APPARATUS REQUIRED : 
 
 

S.No. ITEM RANGE QTY 

1 OP-AMP IC741 1 

2 RESISTOR 1k,27k 2,1 

3 CRO - 1 

4 RPS DUAL(0-30) V 1 

PRE LAB QUESTIONS 
 

1. What is an op-amp? Why it is called so? 

 

2. List the ideal characteristics of an op-amp. 

 

3. What are the building blocks of an op-amp? 

 

4. List the applications of a comparator. 

 

 

 

DESIGN: 
Given : VUT = -VLT =0.5V 

VUT = + Vsat R2/(R1+R2) 

0.5 = 12 (R2/(R1+R2)) 

R1 = 23 R2 

 

Assume R2 = 1kΩ 

Then R1= 23 1kΩ 
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THEORY: 
 

Comparator 
 

 

Schmitt trigger is useful in converting a slowly varying input signal into a square waveforms. 

It is a regenerative comparator . The input voltage is applied to the negative terminal and the feedback 

is applied to the positive input terminal of the op-amp. Tthe output voltage Vo swings between the 

+Vsat and the –Vsat when each time the input signal Vi exceeds the threshold levels VUT and VLT. 

The hysteresis or backlash for a comparator occurs when a positive feedback is employed. It is 

defined as the difference between the VUT and VLT. 

 
PROCEDURE : 

 

1. The connections are made as shown in the circuit diagram. 

2. Apply the input signal of desired amplitude and frequency to the negative input terminal of an 

op-amp. 

3. Compare the input sine signal with the square wave output signal to determine the upper 

threshold voltage (VUT) and the lower threshold voltage (VLT). 

4. Turn the timeperiod knob in CRO to the XY mode and determine the VUT and the VLT values 

and compare it with the previous observation in step 3. 

5. Plot the input signal , output signal and the hysteresis loop in a linear graph. 

 

 
MODEL GRAPH 
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HYSTERESIS LOOP 

 

 

 
POST LAB QUESTIONS 

 

1. Why Schmitt trigger is called as a regenerative comparator? 

 

2. What is Hysteresis? 

 

3. Mention the applications of Schmitt trigger . 

 

 

 

 

 

 

 

 

 

 

 

 
 

RESULT: 
The Schmitt trigger circuit is connected and the waveforms are observed and theoretical and 

practical values of the threshold values are verified. 
VUT(volts) VLT(volts) 

Theoretical values = 

Practical values = 

(From the graph) Hysteresis width  = VUT -VLT = 
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CIRCUIT DIAGRAM 
 

 

 
 

 

MODEL GRAPH 
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EXPT.NO: 4B DESIGN AND SETUP A SAMPLE AND HOLD CIRCUIT 
 

AIM: 
To design and setup a discrete sample and hold circuit using op-amp. 

 

COMPONENTS REQUIRED: 

 
S.No. ITEM RANGE QTY 

1. Bread Board  1 

2. D.S.O (0-3)MHz 1 

3. Op-amp μA 741C 2 

4. BFW10  1 

5. Diode 1N4148 1 

6. Capacitor 82 nF 1 

7. Regulated power supply (0-30)V 1 

 

 

PRE-LAB QUESTIONS 
1. What is the process of down sampling called? 

 

2. What is the main function of (A/D) or ADC converter? 

 

3. The differential predictive signal quantizer system is known as? 

 

 

THEORY: 
 

The sample and hold circuit samples an input signal and holds onto the last sampled value, until the 

input is sampled again. The circuit mainly consists of a sampler or a switching element and a holding 

capacitor. In the circuit JFET used acts as the switching component. The input signal is given to the 

drain of the JFET through a voltage follower and sampling high frequency is given to the gate of 

JFET, through a diode. When the voltage at the gate is zero, the JFET turns on and the capacitor 

charges to the input voltage. When the voltage at the gate is negative, the JFET turns off. As the 

capacitor has no discharge path due to the high impedance at the output of the voltage follower 

circuit, it holds the last sampled voltage. When the JFET is again turns on the capacitor charges to 

the new input voltage. Thus sampling and holding of the input signal occurs. 
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PROCEDURE: 
1. Check all the components. 

2. Set up the discrete sample and hold circuit from a 15V supply. 

3. Use dual output function generator to apply input and sampling frequency simultaneously. 

4. Set the input at 1 KHz, 4V peak to peak sine wave and sampling square wave at 10 KHz, 8V 

peak to peak. Ensure that the negative gate voltage of BFW10 is always less than 4V. 

5. Then observe the input and outputs waveforms in a DSO. 

 

 

 

 

 

POST LAB QUESTIONS 
1. Which amplifier is used in sample and hold circuit? 

2. Why sample and hold circuit is used in integrated circuits? 

3. Why MOSFET is used in sample and hold circuit? 

4. Which MOSFET IC is used to perform sample and hold circuit operation? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RESULT: 
Thus the sample and hold circuit was designed and plotted the input output waveforms. 

Inference: 

The minimum sampling frequency should be twice the input signal. 
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CIRCUIT DIAGRAM USING MCT2E 
 

 

 

 

 
 

 

 

 

 

 

MODEL GRAPH 
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EXPT.NO: 5 DESIGN AND SETUP A PATIENT ISOLATION CIRCUIT 
 

AIM: 
To set up a patient isolation circuit using opto-coupler IC MCT2E. 

 

COMPONENTS REQUIRED: 
 

 
 

S,No ITEM RANGE QTY 

1. Regulated power supply (0 - 30V) 1 

2. Voltmeter (0-10V)MC 1 

3. Ammeter (0-1000µA)MC 1 

4. Photodiode - 1 

5. Resistors 100Ω/1K Ω/10KΩ 1 

6. Bread board, connecting 

wires. 

- 1,few 

 

 

 

PRE-LAB QUESTIONS 
 

1. What is an op-amp isolation? 

2. Which type of amplifier provides an electrical safety barrier and isolation? 

3. What type of amplifier destroys an ordinary op-amp? 

 
 

THEORY: 
 

Phototransistor is a normal transistor in which junction enclosure is transparent to allow light to fall 

on the base emitter junction. At any PN junction hole electron pairs are generated when light falls 

on the junction, so that any light falling on the base emitter junction, produces a current which is 

amplified by transistor action, making the device very sensitive. The dark current increase in a photo 

transistor exponentially with rise in temperature and if the temperature is sufficiently high the dark 

and light currents may be indistinguishable. At any given temperature the dark current can be reduced 

to a small value by biasing the base of the transistor which is normally left open circuited. The 

sensitivity is decreased, but the ratio of light to dark current is increased. The advantages of the photo 

transistor are low power consumption, small size, immediate operation on switching ON, low voltage 

operation and long life. A photo transistor gives a high gain. This transistor is very good for digital 

applications because of the small rise and fall times. 

MCT2E is an opto isolator chip, which is often used to provide isolation and to avoid any electrical 

connection between the input and output stages. The prominent components in MCT2E are a 
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phototransistor and an LED. The phototransistor is made of silicon material and is activated by the 

LED made of Germanium Arsenide. The output light of the LED is infrared and the intensity is 

directly proportional to the potential applied between its two leads. In circuits, where optical isolation 

is required between two stages, the output of the first stage is given to the LED of MCT2E and the 

photo transistor inside the chip transduces the emitted light in to a proportional collector current. 

This is given as the input to the second stage, thus providing electrical isolation. By means of 

providing optical isolation between input and output, interference due to leads and other such artifacts 

can be avoided. Opto-couplers usually finds applications in medical circuits, where patient safety is 

of much importance. 

 

PROCEDURE:   
 

1. Position the pointer at zero on the scale, when the bulb is at maximum distance away from 

sensors. 

2. Switch ON the power supply to the instrument. 

3. Measure the DC voltage output of phototransistor using a millimeter or a CRO across two 

terminals. 

4. Gradually move the bulb towards the sensor in steps of 5mm and note the corresponding 

voltages. 

5. Tabulate the readings and plot the graph of distance versus sensor output voltage and voltage 

versus current. 

 
TABULATION: 

 

VI CHARACTERISTICS D= I-D CHARACTERISTICS VAK = 

S.No. 
Voltage 
VAK (V) 

Current (μA) S.No. Distance(cm) Current (μA) 
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POST-LAB QUESTIONS 

1. How does the mct2e work? 

2. What is the difference between moc3021 and mct2e? 

3. What is an mct2e opto-coupler? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
RESULT: 
Thus the patient isolation circuit using opto-coupler IC MCT2E and photo transistor. 

 
INFERENCE: 

MCT2E can be used as an isolation circuit .Even without any physical contact a signal applied at 

the input can be reproduced at the output. 
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CIRCUIT DIAGRAM 
 

EXPERIMENTAL SET UP 
 

 

MODEL GRAPH 
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EXPT.NO: 6 DESIGN OF BODY TEMPERATURE MEASURING 

CIRCUIT USING THERMISTORS. 
 

AIM: 
To design the body temperature measuring circuit using thermistor and study its characteristics. 

 

COMPONENTS REQUIRED: 

 
S.No. ITEM RANGE QTY 

1. Bread board  1 

2. Variable power supply 0-30 V 1 

3. Thermistor  1 

4. Ammeter (0 - 50mA) 1 

5. Voltmeter (0 – 30V) 1 

6. Thermometer  1 

7. Water bath  1 

8. Resistor 470Ω 1 

9. Bread Board  1 

 

PRE-LAB QUESTIONS 

1. What will happen to resistance, if the length of the conductor is increased? 

2. Which of the following can be measured using change in resistivity? a) Temperature b) Visible 

radiation c) Moisture content d) All of the mentioned 

3. What will happen for resistivity metal and semiconductor if the temperature is increased? 

4. What is the relation of temperature coefficient of resistivity on the coefficient of thermal 

expansion in RTD? 

THEORY: 
Thermistors are the temperature sensitive resistors that exhibit a variation in resistance with 

temperature. In other words electrical resistance of a thermistor will vary when it is placed in an 

environment of changing temperature. The characteristics study of thermistor provides information 

about how its resistance changes with the changes in temperature. Based on the relationship 

between the resistance and temperature thermally sensitive resisters are of two types, one the 

posistor and its resistance increases with increasing temperature (positive temperature coefficient) 

and second the thermistor and its resistance decreases with increasing temperature (negative 

temperature coefficient). Thermistors are very essential in temperature measurement and they are 

made up of the oxides of certain metals like manganese, cobalt and nickel which have negative 

temperature coefficient of resistance. They are formed into rods, discs, washers and bead to suite 

various applications. The application of thermistor includes cardiac output measurements, 

continuous measurement of skin and core body temperature, blood flow 
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measurement and respiratory measurement. They are also used as resistance thermometers in low 

temperature measurements. 

 

PROCEDURE: 
1. Take water in a container and place over the heater. 

2. Immerse thermistor and thermometer in the water bath. 

3. Set up the measuring circuit on the bread board. 

4. Switch on the heater. 

5. Measure the temperature on the thermometer from room temperature to 98oC and note down the 

corresponding resistance of thermistor. 

6. Switch off the heater, and then take reading in decreasing order of temperature in an interval of 

10o C. 

7. Plot a graph of temperature on X-axis and Resistance on Y-axis. This graph shows the 

characteristics of thermistor. 

TABULATION 
 Temp (oC) Resistance(Ω) 

(Up) 
Resistance(Ω) 
(Down) 

   

   

   

POST LAB QUESTIONS 
1. Name the different temperature transducers. 

2. What is thermistor? 

3. What is the temperature range of thermistor? 

4. What is the difference between RTD and thermistor? 

5. What are the materials used to manufacture thermistor? 

RESULT: 
 

Thus the circuit for body temperature measuring circuit using thermistor was designed and and plotted 

the characteristics of thermistor. 

Inference:Temperature and resistance relationship is non-linear for a thermistor.(i.e. 

characteristics of thermistor are non-linear). 
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CIRCUIT DIAGRAM 
 

 

 

MODEL GRAPH 
 

 

 

TABULATION 
 V(volts) I(mA) Pin(mW) R(Ω) 
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EXPT.NO: 7 DESIGN OF PLETHYSMOGRAPHY CIRCUIT  
 

AIM: 
To design a Plethysmography circuit using LDR. 

 
 

COMPONENTS REQUIRED: 
 

S.No. ITEM RANGE QTY 

1. Multimeter  1 

2. LDR - 1 

3. Ammeter (0-100)mA 1 

4. Voltmeter (0-30)V 1 

5. Regulated power supply (0-30)V 1 

6. Bread Board - 1 

7. Bulb - 1 

 

PRE-LAB QUESTIONS 
 

1. Name some resistive transducers. 

2. What is the principle of LDR? 

3. What are the applications of LDR? 

4. State the advantages of LDR. 

5. State the disadvantages of LDR. 

 
THEORY: 

 

A photo resistor is an electronic component whose resistance decreases with increasing incident 

light intensity. It can also be referred to as a light- dependent resistor (LDR), or photoconductor. 

A photoresistor is made of a high resistance semiconductor. If light falling on the device is of high 

enough frequency, photons absorbed by the semiconductor give bound electrons enough energy to 

jump into conduction band. The resulting free electrons (and its hole partner) conduct electricity 

there by lowering resistance.Cadmium selinide or cadmium sulphide are mainly used to construct 

LDRs. Simple cadmium sulphide cells have a wide range of resistance from less than 100ohm in 

bright light to in excess of 10Mohm in darkness. The cells are also capable of reacting to a broad 

range of frequencies including infra-red (IR), visible light and ultra violet. They are often found 

on street lights as automatic on/off switches. In biomedical field it is used in photo plethismography. 
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PROCEDURE: 
1. Setup circuit on the bread board. 

 

2. Vary the DC input in steps from 0V to 30V 

 

3. Note down the ammeter, voltmeter and ohmmeter readings. 

 

4. Calculate the input power Pin = V x I. 

 

5. Plot a graph of Power on X-axis and Resistance on Y-axis. This graph shows the characteristics 

of LDR. 

POST LAB QUESTIONS 
 

1. What does a plethysmograph measure? 

 

2. How is plethysmography done? 

 

3. What is the difference between spirometry and plethysmography? 

 

4. What are the types of plethysmography? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
RESULT: 
Thus the plethysmography circuit was designed and plotted the characteristic curve. 

Dark resistance of LDR = .................. MΩ 

 

INFERENCE: 

The resistance – light intensity relationship is non-linear for a LDR.(i.e. characteristics of LDR is 

non-linear). 
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CIRCUIT DIAGRAM 
 

PIN DIAGRAM 
 

 

 

 

MODEL GRAPH 
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EX.NO.8 DESIGN OF PACE MAKER CIRCUIT 
 

AIM: 
To design a Pace Maker circuit using 555 TIMER for a signal of frequency of 1 KHz and duty 

cycle D = 75% 
 

COMPONENTS REQUIRED: 

 
S.NO ITEM RANGE QTY 

1 IC NE555 1 

2 RESISTOR 7.2kK,3.6 K Each 1 

3 CAPACITOR 0.01F, 0.1F Each 1 

4 RPS (0-30) V 1 

5 CRO - 1 

 
 

PRE-LAB QUESTIONS 
 

1. What is a Multivibrator? 

 

2. What is a Timer IC? 

 

3. Differentiate amplifier and IC. 

 

THEORY: 
The IC555 timer is a 8 pin IC that can be connected to external components for astable operation. 

The simplified block diagram is drawn. The OP-AMP has threshold and control inputs. Whenever 

the threshold voltage exceeds the control voltage, the high output from the OP –AMP will set the 

flip-flop. The collector of discharge transistor goes to pin 7. When this pin is connected to an external 

trimming capacitor, a high Q output from the flip flop will saturate the transistor and discharge the 

capacitor. When Q is low the transistor opens and the capacitor charges. 

The complementary signal out of the flip-flop goes to pin 3 and output. When external reset 

pin is grounded it inhibits the device. The on – off feature is useful in many application. The lower 

OP- AMP inverting terminal input is called the trigger because of the voltage divider. The non- 

inverting input has a voltage of +Vcc/3; the OP-Amp output goes high and resets the flip flop. 

 
DESIGN : 

f = 1.44/(RA+2RB)C 

D = TON/T = RA+RB/(RA+2RB) 

Assume C = 0.1µf 

f = 1.44/(RA+2RB)C , Given f = 1kHz 

1kHz = 1.44/(RA+2RB)0.1 µf 

RA+2RB =14400 ------------- 1 

D = TON/T = RA+RB/(RA+2RB) 
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0.75 = RA+RB/(RA+2RB) 

RB = 0.5 RA 2 

Substitute eqn (2) in eqn (1) RA+ 2(0.5RA) = 14400 

Then RA = 7.2 kΩ RB = 0.5 RA ,    RB = 3.6 kΩ 
 

TABULATION   

Amplitude = (volts) 

TON = (msec) 

TOFF = (msec) 

 

Time period 
 
=TON + TOFF = 

 

(msec) 

 
PROCEDURE: 
1. The connections are made as per the diagram. 

2. The output of the astable multivibrator I at pin 3 is measured and its frequency is verified with 

the theoretical frequency. 

3. For monostable multivibrator the trigger input is given 

4. The output is observed at pin 3 and across capacitor. 

5. The theoretical frequency is verified with the practical. 

6. This experiment can be repeated for various values of c for different frequency 

7. Plot the output graphs. 

 

 

 

 

POST LAB QUESTIONS: 
 
 

1. What is an astable multivibrator? 

2. How astable mode of 555 Timer can be modified to get a square wave generator? 

3. What is an monostable multivibrator? 

4. How monostable mode of 555 Timer is designed? 

5. Define duty cycle. 

 
RESULT: 

 

Thus the Pace Maker circuit. was designed using IC555 and its output waveform is traced. 
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CIRCUIT DIAGRAM 
 

 

 

 

MODEL GRAPH 
 

 

 
TABULATION 

Without jelly With jelly 

F(Hz) V1(V) I(mA) Vzc(V)) Zc(KΩ) F(Hz) V1(V) I(mA) Vzc(V)) Zc(KΩ) 
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EXPT.NO: 9 DESIGN AND SETUP A CIRCUIT FOR SKIN CONTACT  

IMPEDANCE 
 

AIM: 
To design and setup a circuit for skin contact impedance. 

 

COMPONENTS REQUIRED:  

 
S.NO ITEM RANGE Q.TY 

1 Function Generator   

2 Resistor 1 K,47 K Each 1 

3 ECG Electrodes  3 

4 DSO 3 MHz 1 

5 Bread board - 1 

 

PRE-LAB QUESTIONS 
 

1. What is impedance and what is its significance? 

2. How do we reduce contact impedance? 

3. How is skin electrode impedance measured? 

4. What is electrode impedance? 

 
 

THEORY: 

 

The bio electric events are usually measured by means of metallic electrodes placed on the surface 

of the body. The electrical activity generated by various muscles and nerves within the body is 

conducted to the electrode through the body tissues. It reaches electrodes through the skin electrode 

transition and is then conducted by direct wire connection to the input circuit of the recording 

machines. The impedance at the electrode skin interface comes in the overall circuitry of the 

recording machine. Hence the skin electrode impedance is significant of the final recording. Skin 

electrode impedance is called as the contact impedance and is of value greater than the electrical 

impedance of the body tissue as measured beneath the skin. The outer horny layer of the skin is 

responsible for the bulk of skin contact impedance. Jelly is used in order to increase the contact 

between the subject’s skin and the skin electrodes. The skin contact impedance is reduced on the 

application of the jelly. 
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PROCEDURE: 
 

1. Set the function generator output at 2Vpp. 

2. Set up the circuit with switch in position 1 and measure the voltage across 1k by varying the 

input frequency from 0 to 100Hz. 

3. Repeat step 2 after applying jelly. 

4. Set up the circuit with switch in position2 and measure the voltage across Zcby varying input 

frequency from 0 to 100Hz. 

5. Calculate I=V1/1K and calculate Zc=Vzc/I 

6. Plot the frequency Vs impedance graph. 

 

 

 
 

POST LAB QUESTIONS 
1. What is skin impedance? 

2. What is normal skin impedance? 

3. What is skin electrode impedance? 

4. How is skin electrode impedance measured? 

 

 

 

 

 

 

 

 

 

 

 
RESULT: 
Thus the circuit was setup and measured the skin contact impedance with and without jelly. 

Maximum impedance without jelly = ........... Ω 

Minimum impedance without jelly = ........... Ω 

Maximum impedance with jelly = ............Ω 

Minimum impedance with jelly = ........... Ω 

INFERENCE: 
The skin contact impedance is high without jelly so use jelly to reduce the contact impedance while 

measuring biopotentials. 



39 SRMVEC/MDE/BE/LM/III/VI/1910604/MESDL/2023-24/EVEN 
 

EXPT.NO: 10 STUDY OF BIOTELEMETRY 
 

AIM: 

To understand the transmission and reception of biological signal using single channel 

telemetry system 

EQUIPMENTS REQUIRED: 
 

1. ECG Amplifier 

2. Low Pass Filter – 2 Nos. FM Modulator 

3. FM Transmitter 

4. FM Receiver 

5. FM Demodulator 

6. Charger 

7. Battery – 2 Nos. Electrodes 

 

THEORY: 
 

Telemetry is a system of sending data, usually measurements, over a distance. Telemetricdata 

may be physical, environmental or biological. Telemetry is typically used to gather data from 

distant, inaccessible locations, or when data collection would be difficult or dangerous for a 

variety of reasons. In telemetry, specialized instruments carry out measurements of physical 

quantities, and store or transmit the resulting signal, often after some initial signal processing or 

conversion. Biotelemetry is the electrical measuring, transmitting, and recording of qualities, 

properties, and actions of organisms and substances, usually by means of radio transmissions from 

a remote site. There are single channel and multi-channel telemetry systems. For a single channel 

system, a miniature battery operatedradio transmitter is connected to the electrodes of the subject. 

This transmitter broadcasts the bio potential over a limited range to a remotely located receiver, 

which detects the radio signals and recovers the signal for further processing. In this situation there 

is a negligible connection or stray capacitance between the electrode circuit and rest of the system. 

 
Block Diagram Description: 

 

ECG Amplifier 

 

ECG has amplitude of only about 1 mV, so to detect it an amplifier is required. The ECG 

amplifier used here has a Gain of 1000 and CMRR of more than 80dB. 
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Low Pass Filter 

 

A low-pass filter allows low-frequency signals but attenuates (reduces the amplitude of) signals 

with frequencies higher than the cutoff frequency. When the ECG is amplified, the noise is 

amplified too, and often swamps the ECG signal. The noise is usually of a higher frequency than 

the ECG. So the noise can be reduced by low-pass filtering. 

 

 

Block diagram 
 

 

FM Modulator 

 

Modulation is used to embed a message (voice, image, data, etc.) on to a carrier wave for 

transmission. A bandlimited range of frequencies that comprise the message (baseband) is 

translated to a higher range of frequencies. The bandlimited message is preserved, i.e. every 

frequency in that message is scaled by a constant value. Here the incoming ECG signal is modulated 

at around 110MHz. The modulated ECG signal is given to the FM Transmitter. 

FM Transmitter 

FM Transmitter sends a signal (typically 4-20mA) from a process location to a central location 

for control and monitoring. Here FM transmitter transmits the modulated ECG signal. 

FM Receiver 

 

A receiver receives its input through an antenna. It receives the modulated signal from the 

transmitter. The receiver then passes on the information to the FM Demodulator where the ECG 

signal is demodulated to obtain the original ECG signal. FM Demodulator 
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Demodulation, in radio is the technique   of   separating   a   transmitted   audio frequency signal 

from its modulated radio carrier wave. Here the modulated ECG signal is demodulated at a 

frequency  of around 100Hz and the original ECG  signal  is recovered. 

 

PROCEDURE: 
 

Connect the modules as per the block diagram. Switch ON the battery. Connect the ring 

electrodes to the subject. View the transmitted signal on the DSO. 

The various outputs from each of the modules can be viewed on the DSO byconnecting the 

output pin to the desired module. 

 

 

 

 

 

POST LAB QUESTIONS 
 

1. Define telemetry. 

2. What are the types of Telemetry? 

3. What is the purpose of demodulator? 

4. How does telemetry work? 

 

 

 

 

 

 

 

 

 

 

 

 

 

RESULT: 
 

Thus we understand the transmission and reception of biological signal using a telemetry 

system. 
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CIRCUIT DIAGRAM 
 

 
 

 

 

 

MODEL GRAPH 
 

 

 

 

 

 

 

 

 

 

TABULATION 

 
V(volts) R(Ω) C(F) 
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EXPT.NO: 11 DESIGN OF BIO-ELECTRODE EQUIVALENT CIRCUIT 
 

 
 

AIM:  
To design a bio-electrode equivalent circuit for measuring bio potential signals. 

 

COMPONENTS REQUIRED: 

 
S.No. ITEM RANGE QTY 

1. Regulated power supply 0-30 V 1 

2. Bread Board  1 

3. Resistors 300 Ω,20 K ,DRB 1 

4. Capacitors DCB,100 nF 1 

5. Multimeter  1 

 

PRE-LAB QUESTIONS 
 

1. What are bio potential? 

2. How is biopotential measured? 

3. Which type of electrode is preferred for bio potential measurement? 

4. What is a biopotential amplifier? 

 
 

THEORY: 
 

In order to measure and record potentials (currents) in the body, it is necessary to provide some 

interface between the body and the electronic measuring apparatus. Current flows in the measuring 

circuit for at least a fraction of the period of time over which the measurement is made. Bio potential 

electrodes is a transducer that convert the body ionic current in the body into the traditional electronic 

current flowing in the electrode. Current is carried in the body by ions, whereas it is carried in the 

electrode and its lead wire by electrons.Half cell potential is altered when there is current flowing in 

the electrode. Overpotential is the difference between the observed half-cell potential with current 

flow and the equilibrium zero-current half-cell potential. Mechanism Contributed to overpotential -

Ohmic overpotential: voltage drop along the path of the current, and current changes resistance of 

electrolyte and thus, a voltage drop does not follow ohm’s law. - Concentration overpotential: 

Current changes the distribution of ions at the electrode- electrolyte interface - Activation 

overpotential: current changes the rate of oxidation and reduction. Since the activation energy 

barriers for oxidation and reduction are different, the net activation 
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energy depends on the direction of current and this difference appear as voltage. Vp =VR +VC 

+VA. 

 

PROCEDURE 
 

1. The connections are made as per the diagram. 

2. Input is varied from 0 to 2 V and output is measured. 

3. This experiment can be repeated for various values of c 

4. Plot the output graphs. 

. 

POST LAB QUESTIONS 

 

1. What are the three basic types of biopotential electrodes? 

2. What is bio electrode? 

3. How do biopotential electrodes work? 

4. What are Bioelectrodes list 3 properties and applications of Bioelectrode? 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
RESULT: 
Thus the equivalent circuit for bio potential electrode was designed using resistors and capacitors. 
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EXPT.NO: 12 STUDY OF PCB DESIGN SOFTWARE (OPEN 

SOURCE) LIKE KICAD, EAGLE 

AIM: 
To Study of PCB design software (open source) like KiCad, Eagle, etc. 

 

EQUIPMENTS REQUIRED: 
 

KiCad software 

PC 

 

Introduction to KiCad 

KiCad is an open-source software suite for creating electronic circuit schematics, printed circuit 

boards (PCBs), and associated part descriptions. KiCad supports an integrated design workflow in 

which a schematic and corresponding PCB are designed together, as well as standalone workflows 

for special uses. KiCad also includes several utilities to help with circuit and PCB design, including a 

PCB calculator for determining electrical properties of circuit structures, a Gerber viewer for 

inspecting manufacturing files, a 3D viewer for visualizing the finished PCB, and an integrated 

SPICE simulator for inspecting circuit behavior. 

KiCad runs on all major operating systems and a wide range of computer hardware. It supports PCBs 

with up to 32 copper layers and is suitable for creating designs of all complexities. KiCad is 

developed by a volunteer team of software and electrical engineers around the world with a mission 

of creating free and open-source electronics design software suitable for professional designers. 

The latest documentation for KiCad is available at https://docs.kicad.org. 
 

Downloading and installing KiCad 

 

KiCad runs on many operating systems, including Microsoft Windows, Apple macOS, and many 

major Linux distributions. 

You can find the most up to date instructions and download links 

at https://www.kicad.org/download/. 

 

Basic Concepts and Workflow 

 
The typical workflow in KiCad consists of two main tasks: drawing a schematic and laying out a 

circuit board. 

https://docs.kicad.org/
https://www.kicad.org/download/
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The schematic is a symbolic representation of the circuit: which components are used and what 

connections are made between them. Schematic symbols are pictorial representations of electronic 

components in a schematic, such as a zigzag for a resistor or a triangle for an opamp. The schematic 

contains symbols for every component in the design, with wires connecting pins in the symbols. The 

schematic is typically drawn first, before laying out the circuit board. 

The board is the physical realization of the schematic, with component footprints positioned on the 

board and copper tracks making the connections described in the schematic. Footprints are a set of 

copper pads that match the pins on a physical component. When the board is manufactured and 

assembled, the component will be soldered onto its corresponding footprint on the circuit board. 

KiCad has separate windows for drawing the schematic ("Schematic Editor"), laying out the board 

("PCB Editor"), and editing symbols and footprints ("Symbol Editor" and "Footprint Editor"). KiCad 

comes with a large library of high quality, user contributed symbols and footprints, but it is also 

simple to create new symbols and footprints or modify existing symbols and footprints. 

Finally, it is important to understand that KiCad has a project-based workflow. A KiCad project is a 

folder with a project file, a schematic, a board layout, and optionally other associated files such as 

symbol and footprint libraries, simulation data, purchasing information, etc. Many project-related 

settings, including net classes and design rules, are stored at the project level. Opening a board 

outside of its associated project may result in missing design information, so be sure to keep all files 

associated with a project together. 

 
PCB Design Workflow 

 

Typically, the schematic is drawn first. This means adding symbols to the schematic and drawing the 

connections between them. Custom symbols may need to be created if appropriate symbols are not 

already available. At this stage footprints are also selected for each component, with custom 

footprints created as necessary. When the schematic is complete and the design has passed an 

electrical rules check (ERC), the design information in the schematic is transferred to the board editor 

and layout begins. 

The schematic describes which components are in the design and how they are connected; the board 

editor uses this information to make layout easier and to prevent mismatches between the schematic 

and PCB. The layout process requires careful placement of each footprint on the circuit board. After 

component placement, copper tracks are drawn between components based on the connections in the 
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schematic as well as other electrical considerations, such as trace resistance, controlled impedance 

requirements, crosstalk, etc. 

Often the schematic will need to be updated after layout has begun; the schematic changes can be 

easily pulled into the board design. The reverse can often happen: any design changes made in the 

board layout can be pushed back to the schematic to keep the two consistent. 

When the board layout is complete and the board has passed the Design Rules Check (DRC), 

fabrication outputs are generated so that the board can be manufactured by a PCB fabricator. 

 
Tutorial Part 1: Project 

 
 

 

The first thing to do when starting a new design is to create a new project. Opening KiCad will bring 

up the Project Window. Click File → New Project, browse to your desired location, and give your 

project a name, such as getting-started. Make sure the Create a new folder for the project checkbox 

is ticked, then click Save. This will create your project files in a new subfolder with the same name as 

your project. 

 

 

 

At left, the Project Files pane lists the files in the new project. There is a project file with the extension 

.kicad_pro, a schematic file with the extension .kicad_sch, and a board file with the extension 

.kicad_pcb. These files all share a name with your project. 
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There may also be a -backups directory: KiCad will automatically create backups of your project 

when you save, and optionally at fixed time intervals. The backup settings are configurable by going 

to Preferences → Preferences → Common → Project Backup. 

 

 
At right of the Project Window, there are buttons to launch the various tools that KiCad provides. 

Launching these tools will automatically open the associated design file (schematic or PCB) from the 

current project. Start by opening the Schematic Editor. 

 

 

 
Tutorial Part 2: Schematic 

 
Symbol Library Table Setup 

 

The first time the schematic editor is opened, a dialog will appear asking how to configure the global 

symbol library table. The symbol library table tells KiCad which symbol libraries to use and where 

they are located. If you have installed the default libraries with KiCad, which is recommended, select 

the default option: Copy default global symbol library table (recommended). 
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If KiCad cannot find the libraries in their expected installation location, this option will be disabled. 

In this case, the user should choose the second option, Copy custom global symbol library table. 

Click the folder button at the bottom, and browse to the location given below. Select the sym-lib- 

table file. 

The location of the default library table files depends on operating system and may vary based on 

installation location: 

 

 Windows: C:\Program Files\KiCad\6.0\share\kicad\template\
 

 Linux: /usr/share/kicad/template/
 

 macOS: /Applications/KiCad/KiCad.app/Contents/SharedSupport/template/
 

 

 

 

 

 

 

Schematic Editor Basics 
 

To pan around the schematic, click and drag with the middle mouse button or right mouse button. 
 

Zoom in and out with the mousewheel or and F2 . Laptop users may find it useful to change the F1 
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mouse controls to be better suited to a touchpad; the mouse controls are configurable in 

Preferences → Preferences… → Mouse and Touchpad. 

By default, KiCad enables a mouse setting called Center and Warp Cursor on Zoom. When this 

feature is enabled, the mouse cursor is automatically moved to the center of the screen when the user 

zooms in or out. This keeps the zoomed region centered at all times. This feature is unusual, but 

many users find it useful once they get used to it. Try zooming in and out with the mouse cursor in 

different areas of the canvas. If the default zoom behavior is uncomfortable, disable the feature in the 

Mouse and Touchpad preferences. 

 

 
 

 

The toolbar at the left side of the screen contains basic display settings. The toolbar at the right side 

of the screen contains tools for editing the schematic. 

Most tools in KiCad either have default hotkeys assigned, or can have custom hotkeys assigned. To 

view      all     hotkeys,      go     to Help → List      Hotkeys….     Hotkeys     can     be     changed 

in Preferences → Preferences… → Hotkeys. 

 

 

 
Schematic Sheet Setup 
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Before drawing anything in the schematic, set up the schematic sheet itself. Click File → Page 

Settings. Give the schematic a title and date, and change the paper size if desired. 

Adding Symbols to the Schematic 
 

Start making the circuit by adding some symbols to the schematic. Open the Choose Symbol dialog 

 

by clicking the Add a Symbol button on the right side of the window or pressing . 
 

 

This action will trigger the Footprint Library Table Setup dialog. This dialog is equivalent to 

the Symbol Library Table Setup dialog explained earlier, but for footprints instead of symbols. 

 

Again, select the default option: Copy default global footprint library table (recommended). If this is 

option is disabled, select the second option, Copy custom global footprint library table. Click the 

https://docs.kicad.org/6.0/en/getting_started_in_kicad/getting_started_in_kicad.html#sym-lib-table-setup


52 SRMVEC/MDE/BE/LM/III/VI/1910604/MESDL/2022-23/EVEN  

folder button at the bottom, and browse to the location given in the symbol library table setup 

instructions. Select the fp-lib-table file and click OK. 

 

The Choose Symbol dialog lists the available symbol libraries and the component symbols contained 

within them. Basic devices like passive components, diodes, and other generic symbols are found in 

the Device library. Specific devices, such as a particular LED, may be found in other libraries. 

 

Scroll down to the Device library, expand it, and select the LED symbol. Click OK, and click again 

 
to place the symbol in the schematic. 

 

 
Next, add a current-limiting resistor. Go back to the symbol chooser, but this time try searching for a 

resistor by entering R in the filter box at the top. Again, it is found in the Device library. The 

R device is an IEC-style rectangular resistor symbol. An R_US symbol is also available for users who 

prefer the ANSI-style zigzag symbol. Select a resistor symbol and add it to the schematic. 

 

Finally, add a battery to power the LED. The Device library has a suitable Battery_Cell symbol. 

https://docs.kicad.org/6.0/en/getting_started_in_kicad/getting_started_in_kicad.html#sym-lib-table-default-location
https://docs.kicad.org/6.0/en/getting_started_in_kicad/getting_started_in_kicad.html#sym-lib-table-default-location
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Selecting and Moving Objects 

 

Next, position the symbols correctly relative to each other, as shown in the screenshot. Do this by 

selecting, moving, and rotating the symbols. 

 

 
 

In KiCad 6.0, objects are selected by clicking on them. Additional objects can be added to the 

selection with Shift +click, or removed with Ctrl + Shift +click (MacOS: Cmd + Shift +click). 

Drag selection is also possible; dragging from left-to-right selects objects that are entirely enclosed 

by the selection box, while dragging right-to-left also selects objects that are partially enclosed by the 

selection box. and Ctrl + / + Shift can also be used with drag selection to add or 

 

subtract from the selection, respectively. 

 
Note that it is possible to select an entire symbol (by clicking on the symbol shape itself) or to select 

one text field in the symbol without selecting the rest of the symbol (by clicking the text). When just 

a text field is selected, any actions performed will act only on the selected text and not on the rest of 

the symbol. 

 

Selected objects are moved by pressing and rotated by pressing R . The hotkey (drag) can 

 

also be used to move objects. For moving unconnected symbols, and behave identically, but 

 

G 

G 

Shift Shift  Cmd 
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G 

 

for symbols with wires attached, moves the   symbol and keeps the wires attached, 

M 
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Del 

W 

while moves the symbol and leaves the wires behind. Selected objects can be deleted with 
 

the key. 
 

 

Wiring the Schematic 
 

The symbol pins all have small circles on them, indicating that they are not connected. Fix that by 

 
drawing wires between symbol pins as shown in the screenshot. Click the Add a Wire button 

 

on the right-hand toolbar or use the hotkey. Click to start drawing a wire, and finish drawing the 
 

wire by clicking on a symbol pin or double clicking anywhere. Pressing Escape will cancel drawing 

the wire. 

 

 
Another convenient method of drawing wires is to hover over an unconnected pin. The mouse cursor 

will change to indicate that a wire can be drawn starting from that location. Clicking on the pin will 

then begin drawing a wire automatically.Next, add power and ground symbols to the schematic. 

While not strictly necessary in such a simple schematic, these make it easier to understand large 

schematics. 
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Annotation, Symbol Properties, and Footprints 
 

Annotation 

 
Each symbol needs a unique reference designator assigned to it. This process is also known as 

 
annotation. Click the Fill in schematic reference designators button     in the top toolbar. There are 

some options available, but the defaults are fine. Click Annotate and then Close. The symbols are 

now annotated with reference designators R1, D1, and BT1. 

Symbol Properties 
 

Next, fill in values for each component. Select the LED, right-click, and select Properties… ( E ). 
 

This project will use a red LED, so change the Value field to be red. In a real project, it might be 

better to write the LED manufacturer’s part number here instead. Note that it’s possible to edit 

reference designators individually in each symbol’s properties. 

 

This project will use a 3V lithium coin cell battery, so change the Value field of BT1 to 3V. Change 

the resistor’s value to 1k. 

Footprint Assignment 

 
Finally, assign a footprint to each component. This defines how each component will attach to the 

PCB. Some symbols come with footprints pre-assigned, but for many components there are multiple 

possible footprints, so the user needs to select the appropriate one. 

There are several ways to assign footprints, but one convenient way is to use the footprint assignment 

tool by clicking the button in the top toolbar. 

The left pane of this window lists the available footprint libraries. The middle pane shows the 

symbols in the schematic. All of these symbols will get footprints assigned to them. The right pane 

shows the footprints that can be chosen for the symbol selected in the middle pane. Footprints can be 

 

viewed by right-clicking a footprint and selecting View selected footprint. 

 
Many footprints are included with KiCad, so the footprint assignment tool offers several ways to 

filter out footprints that aren’t relevant to the symbol in question. 



SRMV  

 The leftmost button activates filters that can be defined in each symbol. For example, an opamp 

symbol might define filters that show only SOIC and DIP footprints. Sometimes those predefined 

filters are missing or too restrictive, so it can be useful to turn this filter off in some situations.

 The middle button filters by pin count, so that only 8-pad footprints are shown for 8-pin symbols. 

This filter is almost always useful.

 The right button filters by selected library. Libraries are selected in the left pane; footprints not in the 

selected library will be filtered out. This filter is useful as long as it is known which library contains 

the right footprint. Often it’s best to use this filter or the symbol filters, but not both.

 The text box filters out footprints that don’t match the text in the box. This filter is disabled when the 

box is empty.

Using the filters, find and assign the footprints shown in the screenshot above. Click OK. 

 
There are other ways to assign footprints; one way is through the symbol properties window. For 

more information on assigning footprints, see the manual. 

 

Electrical Rules Check 

 

The last remaining thing to do in the schematic is to check for electrical errors. KiCad’s Electrical 

Rules Checker (ERC) cannot make sure that the design in the schematic will work, but it can check 

for some common connection issues such as unconnected pins, two power outputs shorted together, 

or a power input that isn’t powered by anything. It also checks for some other mistakes like symbols 

that aren’t annotated and typos in net labels. To see the full list of electrical rules and to adjust their 

severity, go to Schematic Setup → Electrical Rules → Violation Severity. It is a good idea to run 

ERC before starting layout.Run an electrical rules check by clicking the ERC button in the top 

toolbar and then clicking Run ERC.Even in this simple schematic, KiCad has found two potential 

errors. The errors are listed in the ERC window, and arrows point to the violation locations in the 

schematic. Selecting a violation in the ERC window highlights the corresponding arrow. 

Tutorial Part 3: Circuit Board 

 
With the schematic completed, go back to the Project Window and open the PCB Editor, either by 

clicking the PCB Editor button or opening the board file. 

 

PCB Editor Basics 

https://docs.kicad.org/6.0/en/eeschema/eeschema.html
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Navigation in the PCB Editor is the same as the Schematic editor: pan by dragging with the middle 

mouse button or right mouse button, and zoom with the scrollwheel or F1 / F2 .At far right is the 

Appearance Panel and Selection Filter. The Appearance panel is used to change visibility, colors, and 

opacity of PCB layers, objects, and nets. The active layer is changed by clicking on the name of a 

layer.Below the Appearance Panel is the Selection Filter, which enables and disables selection of 

various types of PCB objects. This is useful to select specific items in a crowded layout. 

 
Board Setup and Stackup 

 
 

 

Before designing the   board, set   the page size   and   add information to the title block. Click 

File → Page Settings…, then choose an appropriate paper size and enter a date, revision, and title. 

Next, go to File → Board Setup… to define how the PCB will be manufactured. The most important 

settings are the stackup, i.e. what copper and dielectric layers the PCB will have (and their 

thicknesses), and the design rules, e.g. sizes and spacing for tracks and vias. 
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To set the stackup, open the Board Stackup → Physical Stackup page of the Board Setup window. 

For this guide, leave the number of copper layers at 2, but more complicated projects might require 

more layers. Next, go to the Design Rules → Constraints page. The settings on this page specify the 

overriding design rules for everything in the board design. For the purposes of this guide, the defaults 

are fine. However, for a real project these should be set according to the capabilities of the PCB fab 

house so that the PCB design is manufacturable. Finally, open the Design Rules → Net Classes 

page. A net class is a set of design rules associated with a specific group of nets. This page lists the 

design rules for each net class in the design and allows assigning nets to each net class. Track width and 

spacing can be managed manually by the designer during layout, but net classes are recommended 

because they provide an automatic way to manage and check design rules.In this design, all nets will 

belong to the Default net class, and the default design rules for this net class are acceptable. Other 

designs may have multiple net classes, each with different design rules. For example a board might 

have a High Current netclass with wide traces, or a 50 Ohm netclass with specific width and clearance 

rules for 50 Ohm controlled-impedance traces. 

 
Drawing A Board Outline 

 

Now the three components have been placed, but the board itself has not been defined. The board is 

defined by drawing a board outline on the Edge.Cuts layer. 

It’s often useful to draw the board outline with a coarse grid, which makes it easy to get round 

numbers for the board size. Switch to a coarse grid by selecting 1mm in the Grid dropdown menu 

above the canvas. To draw on the Edge.Cuts layer, click Edge.Cuts in the Layers tab of the 

Appearance panel at right. Choose the rectangle tool in the right toolbar, and use it to draw a rectangle 

roughly surrounding the three footprints. The other graphic tools (line , arc , circle , or polygon ) 

could also be used to define the board outline; the only requirement is that the outline is a single 

closed shape that doesn’t intersect itself. 

 
Placing Footprints 

 

The next step in the layout process is to arrange the footprints on the board. In general, there are a 

several considerations for positioning footprints: 

 Some footprints may have exact requirements for their locations, such as connectors, indicators, or 

buttons and switches.
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 Some components may need to be placed according to electrical considerations. Bypass capacitors 

should be close to the power pins of the associated IC and sensitive analog components should be far 

from digital interference.

 Almost all components have a "Courtyard" (or two if both Front and Back are defined). Generally 

Courtyards should not intersect.

 Otherwise components should be positioned for ease of routing. Connected components should 

generally be close together, and arranged to minimize routing complexity. The ratsnest (the thin lines 

indicating connections between pads) is useful for determining how best position footprints relative 

to other footprints.

For the purposes of this guide, the only placement goal is to make the routing process as simple as 

possible.Start by moving the battery holder BT1 onto the back side of the board. Click it to select it, 

then press to move it. Press to flip it to the opposite side; it now appears mirrored and its pads 

 

have changed from red to blue. 

 
All PCB layers are viewed from front side of the board. Footprints on the bottom of the board are 

therefore upside down and appear mirrored. 

Each PCB layer has a unique color, which is shown by the swatches in the Layers tab of the 

Appearance panel. In the default color scheme, items on the F.Cu (Front Copper) layer are red, while 

items on the B.Cu (Back Copper) are blue. 

Now place the other two components. One at a time, select each component, then move and rotate it 
 

with and R . Watch the ratsnest lines between each pad to choose the simplest arrangement of 

 

components; a good arrangement will leave the lines untangled. One possible arrangement is shown 

in the screenshot below. 

EAGLE is available from Autodesk either as part of the Fusion 360 software package or you can a 

free version of just EAGLE here. Grab the version that matches your operating system (the software 

is available for Windows, Mac and Linux). It's a relatively light download -- about 125MB. 

EAGLE installs just like most programs. The download is an executable file; open it and follow the 

installation instructions. 

 

Licensing EAGLE 

 

 

F 

https://www.autodesk.com/products/fusion-360/overview
https://www.autodesk.com/products/eagle/free-download
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One of our favorite things about EAGLE is that it can be used for free! The free download is limited 

version for hobbyists. The free download is a Personal Learning License that may be used by 

individuals for personal, non-commercial use. There are a few limitations to be aware of when using 

the free version: 

 

 Your PCB design is limited to a maximum size of 80cm2 (12.4in2) of PCB real estate, which is still 

pretty darn big. Even if you're designing a big 'ol Arduino shield, you'll still be well under the 

maximum size.

 Only two signal layers allowed. If you need more layers look into upgrading to the single-user Fusion 

360 license.

 Only two sheets in your schematic editor.

 The Personal Learning License is limited to personal, non-commercial use by individuals. If you're 

going to go out and sell your design, you'll want to check out the single-user EAGLE license included 

with a Fusion 360 License.

 

Those limitations still make EAGLE an amazing piece of software. Engineers here at SparkFun could 

design 99% of our boards using the freeware version, if not for that pesky non-profit 

stipulation. You still have access to all phases of the EAGLE software, including the Autorouter. 

 
Step 1: Download the SparkFun Libraries 

 

Step 2: Updating the Directories Window 
 

Step 3: "Using" Libraries 
 

Opening a Project and Explore 

EAGLE is packaged with a handful of nifty example PCB designs. Open one up by expanding the 

"Projects" tree. From there, under the "examples" folder open up the "arduino" project by double- 

clicking the red folder (or right-clicking and selecting "Open project"). Note that, in this view, project 

folders are red and regular folders are the standard yellow. 

https://learn.sparkfun.com/tutorials/arduino-shields
https://www.autodesk.com/products/eagle/overview
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Opening the project should cause two more EAGLE windows to spawn: the board and schematic 

editors. These are the yin and the yang of EAGLE. They should be used together to create the finished 

product that is a functional PCB design. 

 

The schematic editor (on the left above) is a collection of red circuit symbols which are 

interconnected with green nets (or wires). A project's schematic is like the comments in a program's 

code. It helps tell the story of what the board design actually does, but it doesn't have much influence 

on the end product. Parts in a schematic aren't precisely measured, they're laid out and connected in 

a way that's easy to read, to help you and others understand what's going on with the board design. 

The board editor is where the real magic happens. Here colorful layers overlap and intersect to 

create a precisely measured PCB design. Two copper layers -- red on top, blue on the bottom -- are 

strategically routed to make sure different signals don't intersect and short out. Yellow circles (on 

this design, but they're more often green) called "vias" pass a signal from one side to the other. Bigger 

vias allow for through-hole parts to be inserted and soldered to the board. Other, currently hidden, 

layers expose copper so components can be soldered to it. 
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Keep Both Windows Open! 

Both of these windows work hand-in-hand. Any changes made to the schematic are automatically 

reflected in the board editor. Whenever you're modifying a design it's important to keep both 

windows open at all times. 

If, for instance, you closed the board window of a design, but continued to modify a schematic. The 

changes you made to the schematic wouldn't be reflected in the board design. This is bad. The 

schematic and board design should always be consistent. It's really painful to backtrack any changes 

in an effort to reattain consistency. Always keep both windows open! 

There are a few ways to tell if you don't have consistency between windows. First, there's a "dot" 

in the lower-right hand corner of both windows. If the dot is green, everything is groovy. If the dot 

is magenta, a window's probably closed that shouldn't be. Second, and more obvious, if you close 

either of the two windows a big, huge warning should pop up. 

 
Navigating the View 

This is a subject that's usually glazed over, but it's important to know how to navigate around both 

of these windows. 

To move around within an editor window, a mouse with a scroll wheel comes in very handy. You 

can zoom in and out by rotating the wheel forward and backward. Pressing the wheel down, and 

moving the mouse allows you to drag the screen around. 

 
Configuring the UI 

EAGLE's user interface is highly customizable. Anything from the background color, to layer colors, 

to key bindings can be modified to fit your preference. Better tailoring your interface can make 

designing a PCB much easier. On this page we'll talk about how we at SparkFun prefer to customize 

our UI. None of these steps are required. Customize your UI as you see fit. These are just the settings 

that we've grown accustomed to. 

 
Setting the Background Color 

The first adjustment we always make to the UI is the background color of the board editor. The 

standard white background doesn't always meld very well with the array of colored layers required 

for board design. Instead, we usually opt for a black background. 

To change the background color, go up to the "Options" menu and select "User interface". 

Inside the "Layout" box you can set the background to black, white, or a specific color. 

 

 

 

 

 

 

RESULT: 

Thus PCB design software (open source) was studied using KiCad, and Eagle. 
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CIRCUIT DIAGRAM: 
 

PLL 
 
 

 

 

 

 

PIN DIAGRAM 
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EX.NO:13 PHASE LOCKED LOOP CHARACTERISTICS 
 

AIM: 
To construct and study the operation of Phase Locked Loop(PLL) IC 565 and determine its 

Characteristics. 

 

APPARATUS REQUIRED: 
 

S.No ITEM RANGE QTY 

1 IC 565 - 1 

2 Resistors 6.8 K 1 

3 Capacitors 0.001 F 

0.1 F, 1 F 

1 each 

4 Function 

Generator (Digital) 

1 Hz – 2 MHz 1 

5 C.R.O - 1 

6 Dual Power 

Supply 

0- 30 V 1 

 

PRE LAB QUESTIONS: 
 

1. What is a VCO? 

2. What is PLL? 

3. List the features of PLL. 

4. Mention The applications of PLL 

 
FORMULA 

 

Free running frequency fo = 0.25/(RTCT ) 

Lock – in range fL=  7.8 fo / V 

Where , V = +Vcc – (-Vcc) 

Capture Range  fc =  (fL/ (2)(3.6)(103) C)1/2
 

THEORY: 
 

 

The PLL consists of Phase detector, Low Pass Filter, Error Amplifierand VCO. The 

VCO is a free running Multivibrator operates at f0called free running frequency. The frequency 

deviation is directlyproportional to the DC control voltage and hence it is called as VCO.If an input 

signal Vs of frequency fs is applied to the PLL , the phasedetector compares the phaseand 

frequency of the incoming signal tothat of the output V0 of the VCO, if the two signals differs 

infrequency or phase an error voltage is generated, then the phasedetector is a multiplier and 
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produces fs±f0 , the high frequencycomponent fs+f0 is removed by LPF and the Low 

frequencycomponent is amplified and applied as a control voltage to VCO. Vcshifts the VCO 

frequency to reduce the frequency difference between fs and f0, once this action starts the signals 

is in the capture range. The VCO continues to change the frequency till its output frequency is 

same as the input frequency then it is said to be a locked range. 

 

MODEL GRAPH: 
 

 

 

 

 

PROCEDURE: 

1. The connections are given as per the circuit diagram. 

2. Measure the free running frequency of VCO at pin 4, with the input signal Vi set equal to 

zero. Compare it with the calculated value of fo= 0.25 / (RT CT). 

3. Now apply the input signal of 1 VPP square wave at a 1 KHz to pin 2. Connect one channel 

of the scope to pin 2 and display this signal on the scope. 

4. Gradually increase the input frequency till the PLL is locked to 

the input frequency. This frequency f1 gives the lower end of the capture range. Go on increasing 

the input frequency, till PLL tracks the input signal, say, to a frequency f2.This frequency f2 gives 

the upper end of the lock range. If input frequency is increased further, the loop will get unlocked. 

5. Now gradually decrease the input frequency till the PLL is again locked. This is the 

frequency f3, the upper end of the capture range. Keep on decreasing the input frequency until the 

loop is unlocked. This frequency f4 gives the lower end of the lock range. 

6. The lock range fL= (f2 – f4).Compare it with the theoretical value of fL.The capture range 

is fc = (f3 – f1).Compare it with the theoretical  value of capture range 
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TABULATION  
 

Amplitude of input and output signal - 

 

S.No. Input Frequency 
(kHz) 

Output Frequency 
(kHz) 

   

 

POST LAB QUESTIONS: 
 
 

1. Define Phase Locked Loop. 

2. What are the building blocks of a PLL? 

3. What is capture range in PLL? 

4. What is lock –in range in PLL? 

5. What is free running frequency in PLL? 

 

 

 

 

 

 

 

 

RESULT: 
 

Thus the PLL circuit  is constructed and its characteristics are determined and the frequency 

multiplier circuit using PLLis constructed and studied. 


